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Welcome to the latest edition of my monthly Final Cut Studio newsletter for February, 2009.

The goal of this newsletter is to provide information helpful to the professional user 
of Final Cut Pro. This newsletter publishes each month. Key articles from past 
issues are posted on my website each month for your reference. At the end of 
each year, all newsletters for that year are bundled and available in my store. All 
software references are to Final Cut Studio 2 unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll 
find daily tips, latest industry news, over 400 articles and tutorials to help you get 
the most out of Final Cut!
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WRAP-UP 

WELCOME

Well, it looks like winter isn't ready to let go of us yet, Punxsutawney Phil says we have six more 
weeks of winter. So, here's a whole bunch of Final Cut Studio goodies to keep you warm on a 
cold night.

First, though, I want to take a minute to thank everyone that sends in questions and comments. 
Part of the fun of writing this newsletter is reading what you think and adding your comments to 
each issue. It is your feedback that makes this newsletter unique -- and especially valuable to 
everyone else.

I'm about to head out on another seminar tour -- though not as many cities this time. What I find 
especially exciting is that we have sold out one city and are close to selling out two more. It is a 
real treat to have a standing-room only event. I'm very honored that so many people are 
interested in our seminars. (More on that in a second.)

One other note. I know that the economy is hard on all of us. Partly its the slowdown in work, but 
even more is the uncertainty of not knowing how much worse things are going to get. Still, there 
are many reasons for optimism. I try not to get caught up in rumor and speculation. There are 
other writers and websites that do. But a number of different vendors have shared some of their 
up-coming product plans with me and I think we have a very interesting year ahead of us.

I'm looking forward to sharing it with you. If there is anything I can do to help, please let me 
know. 

[ Go to Top. ] 

 

LAST CALL! LARRY'S POWERUP SEMINARS START SOON!

February is "International Seminar Travel Month," so I'm packing an extra-large suitcase and 
hitting the road. We will be visiting:

http://www.groundhog.org/
http://www.larryjordan.biz/seminars


* Feb. 5 - 6: Orlando, Florida - Assn. of Video Professionals 

Discover the Hidden Power in Final Cut Studio 
Integrating Adobe Software into a Final Cut Workflow 

* Feb. 12: Dundee, Scotland

Final Cut Pro Workflow Secrets - 4 hours -- www.larryjordan.biz/
seminars

* Feb. 13: Glasgow, Scotland -- SOLD OUT!! 

Final Cut Studio Pro Techniques - 8 hours -- www.larryjordan.biz/
seminars

* Feb. 17-19: London, England - Broadcast/Video Forum 2009 

A series of trade show seminars -- www.broadcastvideoexpo.co.uk

* Feb. 20: London, England -- TEN SEATS LEFT! 

Final Cut Studio Pro Techniques - 8 hours -- www.larryjordan.biz/
seminars

* Feb. 21 - 22: Dublin, Ireland

Final Cut Pro Workflow Secrets - 8 hours 
Final Cut Studio Pro Techniques - 8 hours 
Contact: Adrian Brett -- adobrett00@hotmail.com

Thanks to the generosity of our sponsors, we are able to keep the price EXTREMELY low. 
Because of that, turnout is greater than we expected. Please register quickly - as seats are 
filling fast.

Click here to learn more or to register. I look forward to seeing you there! 

[ Go to Top. ] 

TECHNIQUE: BENEFITS OF MAKEUP 

Over the years, I've done a lot of documentary producing and shooting. The talking-head 
interview is something I've done hundreds of times. 

When dealing with non-professional talent, there are three challenges I always keep in mind:

�●     They are terrified of being on camera, so keeping them loose and relaxed is critical.
�●     They will unconsciously phrase their answer based upon how I ask the question, so I 

never ask a question that can be answered with a 'yes' or 'no'.
�●     They have no clue how to look good on camera, so I always bring makeup.

http://aovpros.com/training.php
http://www.larryjordan.biz/seminars
http://www.larryjordan.biz/seminars
http://www.larryjordan.biz/seminars
http://www.larryjordan.biz/seminars
http://www.broadcastvideoexpo.co.uk/
http://www.larryjordan.biz/seminars
http://www.larryjordan.biz/seminars
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Most women are completely comfortable wearing and adjusting makeup. However, asking a guy 
to wear makeup is about the same as asking them to sing in front of a group of their friends. 
They are going to be very, very uncomfortable.

Also, most of the shoots I go on don't have the budget for a hair and makeup person. Which 
means I need to do the makeup myself.

We now have the worst of all situations: a very, very nervous amateur being made up by another 
guy. Sigh... The things I do for my craft.

Recently, I was in the studio doing some shooting for a book I'm writing -- I needed to create 
some video examples that I could use in screen shots. So, while I was there, I asked Andrew, 
one of our actors, to pose for a before and after makeup picture.

The "before" is on the left, the "after" is on the right. See the huge hot spot in the middle of his 
forehead? Notice how his whole face seems to be glowing, just sitting there he looks 
uncomfortable.

On the right is the same actor under the same lighting - this time wearing makeup. 

A product I've used for the last fifteen years can quickly make people look 
good under lights. Its made by Lancolm and its called: Pure Focus T-Zone 
Powder Gel. It costs $25 - 30 and is worth every penny.

A tube provides coverage for dozens of interviews. I suggest you apply it 
from cheekbones up into the hairline. It is very thick and a little goes a long 
way. Rub it in well. 

I've also learned that guys are most comfortable, when you want to put 

http://www.lancome-usa.com/skincare/moisturizers/pure-focus-t-zone-matifier.htm
http://www.lancome-usa.com/skincare/moisturizers/pure-focus-t-zone-matifier.htm


makeup on them, if you distract them with a story. Anything to keep them 
from thinking about wearing makeup. I tend to talk about how great they are 
going to look walking around the office later in the day. I may, perhaps, 
exaggerate the effect a bit. 

Nothing makes your lighting look great like a face that doesn't reflect it back 
to the camera like a mirror.

UPDATE - Feb. 3, 2009

Craig Sommerer sent in the following:

Finally, you've addressed something very fundamental that few people seem to 
understand; the talent needs to look good, regardless of what they look like. 

I am a freelance video operator for live multi-camera events and my big TV 
cameras have a skin detail circuit, a selective de-focus, to help blur out the 
contours on talent. 

"Pro-sumer" cameras also have a very ineffective skin detail circuit which quite 
honestly, shouldn't be used, as the defocus parameters are not selectable.

Your Lancome hint is great. Now take your talent's looks to the next level with 
Patrick Sheffield's "Electronic Makeup Artist" and "Digital Coverup" filters for Final 
Cut Pro. The "Electronic Makeup Artist" effects are astounding, in other words, a 
little bit goes a long way. http://www.sheffieldsoftworks.com/

Full disclosure, while I'm listed in the sidebar on the website of Sheffield 
Softworks, I make no financial compensation from spreading the good word. I 
hope you give these filters, as well as Pat's free filters a try.

Larry replies: Thanks, Craig, for your comments. 

[ Go to Top. ] 

LARRY PRESENTS POWERUP TUTORIALS -- ON VIDEO 

In my survey around the first of the year, one of the things you strongly requested were short, 
timely, focused video tutorials covering Final Cut Studio and new technology. So, in response, 
I've created almost two dozen on-line video tutorials -- each covering a very specific subject in 
depth.

In an effort not to repeat material that is available elsewhere, I try, in each tutorial, to either 
present material that I've not done before or present additional ways to accomplish each task. I 
also look for ways to present new technology so you can see whether it makes sense for you 
and your projects.

Recently, we've added new tutorials, and I'll be working more when I get back from the UK. 

For a complete list of titles available, click here. (This list changes often, so please check back 
frequently.)

If you have specific training ideas, please click here and email me!

http://www.sheffieldsoftworks.com/
http://www.larryjordan.biz/training/online_tutorials.html
mailto:Larry@larryjordan.biz?Subject=Ideas for Training Tutorials
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TECHNIQUE: CUSTOMIZING KEYBOARD SHORTCUTS

I read somewhere that Final Cut Pro has 650 menus. Sheesh! No wonder we sometimes get lost 
trying to find the menu to do something.

Final Cut 6 also has 392 keyboard shortcuts. (I know -- I just counted them! I'll show you how 
to do the same a little later in this tutorial.) However, even with almost 400 shortcuts to choose 
from, sometimes, we just don't have the ones we need. 

Wouldn't it be great if we could customize our own keyboard shortcuts? 

Ta-DAH! We can. Even better, this process is the same for Final Cut Pro 4, HD, 5, and 6; though 
the default keyboard shortcuts differ between versions. 

First, start Final Cut, though you don't necessarily need to open any projects.

Select Tools > Keyboard > Customize...



The keyboard illustration depends upon what keyboard you have connected to your Mac. In this 
case, this shows a full-size keyboard. If you have a laptop, the keyboard will look like your laptop 
keyboard.

A very useful window layout, to me, is the Two-Up layout (Windows > Arrange > Two-up). It 
makes the Browser and Timeline smaller so that the Canvas and Viewer can be bigger. The 
problem is that it doesn't have a keyboard shortcut.

Hmmmm.... If the default window layout is Control+U, seems to me it would be really useful if 
this Two-up layout were Shift+Control+U. Here are the steps to create this shortcut.

To prevent accidental changes to your keyboard shortcuts, the keyboard is locked. This is not for 
security, but simply to prevent accidental changes. 

Unlock the keyboard by clicking the lock icon in the lower left corner.

Next, in the search box on the right, type a portion of the menu you want to turn into a shortcut. 
You need to type the text exactly as it appears in the menu, but you don't need to type the entire 
phrase. For instance, here I've just typed Two and it found the window menu I was looking for.

Note: You can also type a keyboard shortcut and it will find the menu that the 
shortcut is assigned to. I use this a lot to figure out what various key combinations 
do.



Across the top of the keyboard image are a series of tabs. These correspond to the various 
combinations of modifier keys that can be held while typing a shortcut. (It is interesting to me that 
these tabs don't allow any three key shortcuts -- probably because they had more than enough 
keys using the ten tab combinations that they have. Ten? Yes. Nine that use modifier keys and 
one that doesn't.)

Since we want to make Shift+Control+U our new keyboard shortcut to switch to the Two-up 
window layout, click the Control+Shift tab.

Then, from the search results box, where Two-up is displayed, drag the ICON on top of the letter 
U.

When you let go, you have a new keyboard shortcut.

Notice that at the right side of the search results window, the new shortcut is listed next to the 
menu item.

Hmmm... remember at the beginning of this technique I mentioned that there are 392 default 
shortcuts in Final Cut 6? Well, here's how to get a complete list of them.

With the keyboard still displayed, go to Tools > Keyboard Layout. 



If you want to export a list that is read best in Excel -- a tab-delimited table -- select Save Grid as 
Text. If you want a list that is more easily read in Word, select Save All Commands as Text. 
The other two choices allows you to group your shortcuts prior to export.

[ Go to Top. ] 

LARRY IS WRITING A NEW BOOK AND NEEDS YOUR HELP

Based on the success of our Fall PowerUP Seminars, Focal Press has asked me to write a book 
titled: Adobe Production Premium for Final Cut Editors.

This will look at all the ways that Final Cut editors can use Adobe software to work faster or do 
things that just aren't possible with Final Cut Studio by itself.

And that's where I need your help -- I'm looking for stories on how editors are using BOTH Adobe 
and Apple software. I'm looking for more than just stories on After Effects or Photoshop. Fore 
example, if you regularly use Bridge, OnLocation, Soundbooth, Illustrator, Flash encoding, or 
other Adobe software, I'd like to hear from you.

If you would like to appear in the book, along with your photo, website and credits, drop me a 
note. I'm looking for 250-300 words describing how you use the software. There's no money in it, 
but I'll do what I can to provide world-wide fame!

The book is scheduled to come out in the late spring -- so please let me know immediately. I only 
have room for about eight more stories.

Click here to let me know you are interested. DON'T send your story until we chat.

[ Go to Top. ] 

TECHNIQUE: WORLD'S FASTEST KEYBOARD SHORTCUT FINDER

I was surprised to discover that I have not written about a technique that I use in almost every 
project: a very fast way to find a keyboard shortcut or menu.

Apple has hidden it in plain sight: its called the Button List.

mailto:Larry@larryjordan.biz?Subject=Larry, I want to be in your book!


To display it, choose Tools > Button List.

An instant later, when it appears, it lists the 30 different groups of menus inside Final Cut Pro. 

To see just how extensive this list is, twirl down any one of the categories. For instance, here is 
just a partial list of the menu choices in the File menu. The left side of the list is the menu name, 
on the right side is the keyboard shortcut assigned to it - if any.



Note: If you have created custom keyboard shortcuts, they will appear in this list 
as well. This does not distinguish between custom and default keyboard shortcuts.

Here is where the Button List gets REALLY helpful.

In the search box, type the first letter or two of what you are looking for. For instance, type the 
letter W and see all the keyboard shortcuts that contain the letter "W."

Or type just the first letters of a menu choice and see if there's a shortcut assigned to it.

This is just such a flat-out fast way to find shortcuts that I find myself using it on a regular basis.

[ Go to Top. ] 

DON'T FORGET TO VISIT LARRY'S BLOG

If you haven't visited recently, take a couple of minutes and check out my blog. I use this as a 
way to update you between newsletters - or comment on what's going on in the industry.

For instance, Bruce Nazarian and I had a great time putting together the Special Report - The 
State of Blu-ray a couple weeks ago. I've posted an excerpt on creating Blu-ray Discs on a Mac 
that you need to listen to if you plan to move into this new technology.

http://www.larryjordan.biz/app_bin/wordpress/archives/414/trackback

Another good example of stories you'll find are extensions on the interviews I do for the weekly 
Digital Production Buzz. For instance, recently, we had Chris Zapara on the show talking about 
his Emmy Award-winning visual effects.

Chris shared some examples of his work and some of his software tools, which you can find here:

http://www.larryjordan.biz/app_bin/wordpress/archives/389/trackback 

Here's where you can find my blog -- be sure to subscribe to the RSS feed to be notified when 

http://www.larryjordan.biz/app_bin/wordpress/archives/414/trackback
http://www.digitalproductionbuzz.com/
http://www.larryjordan.biz/app_bin/wordpress/archives/389/trackback
http://www.larryjordan.biz/blog


something new shows up. Check back from time to time -- I'll also be doing reports during my 
seminar trip overseas.

[ Go to Top. ] 

DIGITAL PRODUCTION BUZZ IS NOW ON WSRADIO

We are now broadcasting the highlights of Digital Production BuZZ each month on Video 
Production Radio -- syndicated by wsRADIO. The Internet is becoming the future of 
broadcasting. Now, with wsRADIO and the BuZZ, you have one more way to stay current.

The show is updated the second Thursday of each month.

January's show featured:

�●     Norman Hollyn - USC Film School on editing
�●     Charlie Paul - world-class directon on shooting food
�●     Brent Altomare - on growing a production company
�●     Philip Hodgetts - technology trends to watch in 2009
�●     Bruce Nazarian - making sense of optical media

The February show, to be posted Feb. 12, features a summary of our Special Report - The State 
of Blu-ray, with myself and Bruce Nazarian.

You can learn more about the series here: feed://www.wsradio.com/podcasts/231.xml

[ Go to Top. ] 

TECHNIQUE: CREATING CUSTOM-SIZED SEQUENCES

You may have heard that Final Cut sequences can be customized. But what you may not know 
is how significantly you can make changes -- as long as you don't want to play the results on a 
DVD or record them to video tape.

However, since more and more material is moving directly to the web, the ability to create eye-
catching video using Final Cut in non-standard ways is worth exploring.

So, let's make a giant turn off the straight path to video output and see what we can do to make 
things more interesting.

First, keep in mind that in order for a video to play on the web, it needs to be compressed. 
Specifically, compressed using the H.264 codec. This means that all we need to do in Final Cut 
is to create the master file that will then be compressed for the web. 

Also, within Final Cut, as soon as you move away from standard video image sizes, you'll need 
to render -- but, if you were to create a special effect in After Effects, you'd render there, too. 
Think of this as another of Final Cut's special effects and don't let the rendering deter you. 

Let's create a long, horizontal clip of a train running through an entire valley. The shot we are 
going to use was shot on a misty morning along the Amtrak line near Pismo Beach in California.

http://www.digitalproductionbuzz.com/
feed://www.wsradio.com/podcasts/231.xml
feed://www.wsradio.com/podcasts/231.xml
http://www.wsradio.com/
feed://www.wsradio.com/podcasts/231.xml


Here is a standard DV clip. As we know, a DV image is 720 x 480. But, what happens if we 
change that.

Start by going to Sequence > Settings.



First, change the Aspect Ratio pop-up to Custom (not Custom 3:2).

Then, change the image size to something unusual -- in this case, I'll use 720 x 200. That keeps 
the horizontal part of the image, but severely crops the vertical.

Note: Final Cut sequences have a maximum dimension of 4,000 pixels on a side.

Since I'm working with DV video, I'll leave the Pixel Aspect Ratio alone. I don't want to change 
the shape of the video pixels, merely the shape of the sequence it plays in.

Next, change the Compressor to Animation. This codec is the highest quality codec you can use 
in Final Cut. The only problem is that is generates HUGE file sizes and, in most cases, can't be 
played in real-time.

However, since this will be compressed for the web, which WILL allow the clip to play in real-
time, we don't care about real-time playback in FCP.

Click OK to save your changes.



Note the entirely different look of the Canvas! Now, when we edit our video into the timeline, 
watch what happens.

Hmm... we get a dialog. In this case, we do NOT want to change the sequence settings to match 
the video. Click No.



Hmmm..., again. Now our video looks severely pillar-boxed. That's because whenever the image 
size and sequence size don't match, Final Cut will always scale the image so that the entire 
image fits into the sequence. 

In this case, we don't want that. We need to enlarge the image so that it completely fills the 
sequence.

So, double-click the clip in the timeline to load it into the Viewer, click the Motion tab, and 
change the scale to 100%. (In our case, the scale was reduced to 41.67% in order for the entire 
image to fit.

The last thing we need to adjust is the vertical position of the image. Because we don't see the 
entire image, we may need to tweak it so that the best part of the image fits into our new frame.



In this case, I need to the train a bit so that it doesn't disappear under the bottom of the frame.

Do this by changing the Center settings in the Motion tab. The left box controls horizontal 
position. Set this to 0 so that the image doesn't move horizontally. Change the right box to move 
the train up or down until it fits the best in the frame. In this example, I raised it 68 pixels.

Here's our finished video in a custom-made sequence. 

Cool!

If you want to see this in motion, you can either render it - which because we are using the 
Animation codec may, or may not, play on your system. Or, what I tend to do, is put the playhead 
where I want playback to start and press Option+P. This plays a sequence that requires 
rendering, without first rendering it. (It is slower than real-time, but it still plays!)



For instance, here is a sequence I created that is 1,440 x 200 pixels. In this case, I stacked two 
clips above each other, and moved the Center point of one to fill the left side of the sequence, 
while other clip's center point was moved to fill the right. I then adjusted the vertical position so 
the tracks matched.

Note: This was actually two different trains, shot at different times, which you can 
tell because the train on the right ends before the train on the left. 

So you can see the results for yourself, here's a movie of our 720 x 200 sequence. (Silent -- 
TRT: 0:37 4 MB -- this may take a few moments to load.)

Even more dramatic, here's a movie of our 1440 x 200 sequence. (Silent -- TRT: 0:15 1.8 MB)

Both movies were compressed exporting out of QuickTime using the H.264 codec.

Imagine what you could do with movies shaped like this -- or any other size -- on your website - 
or in digital signage - or on any computer monitor! Just remember, you can't play movies like this 
on a TV set.

This is fun!
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BACK ISSUES OF ALL LARRY'S 2008 NEWSLETTERS -- 
NOW AVAILABLE!

http://www.larryjordan.biz/assets/nxltr53/720x200_sequence.mov
http://www.larryjordan.biz/assets/nxltr53/720x200_sequence.mov
http://www.larryjordan.biz/assets/nxltr53/1440x200_sequence.mov
http://www.larryjordan.biz/assets/nxltr53/1440x200_sequence.mov


  
  
  
  
  
  
  
  
  
  

I've been getting a lot of requests for newsletter back issues. So, as we do each year, I've 
created PDFs of the updated versions of each issue and gathered them all together so you can 
have the complete 2008 collection.

Even better, all these issues are available today for immediate download!

My 2008 newsletters provided 327 pages of Final Cut Studio techniques, tips, and secrets. 
Everything from the simple tips to complex -- with step-by-step procedures to show you the way. 
They are stored in PDF format which makes searching and storage easy.

Even better, due to the increased demand, we've reduced the price on all our newsletter 
collections.

Click here to order your download today!
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TECHNIQUE: CONVERTING .M2T FILES TO .MOV FILES

The native format of HDV isn't QuickTime, its .M2T.

M2T, otherwise called an MPEG-2 Transport stream, is not the same thing as the standard 
MPEG-2 file that we create in Compressor to use in DVD Studio Pro. I was told recently that 
there are 14 different versions of MPEG-2, which I find strangely reassuring. Why should there 
be any more standardization in compressed files than there is in video formats?

Sigh... the world is perverse.

Anyway, while working on my latest book, I needed to convert .M2T files into something that 
Final Cut can edit. Final Cut likes lots and lots of different files - but not .M2T.

This means that if someone captures an HDV file in another application, such as Adobe 
OnLocation or Adobe Premiere, then sends it to you, you'll need to transcode it to QuickTime 
before bringing it into Final Cut.

Note: You can not use QuickTime Player to preview an M2T file. The Finder 
displays it as a generic document icon. 

There are a variety of ways of doing this, but the two easiest are:

* Compressor 
* MPEG Streamclip

The benefits to using Compressor is that you already own the software, its fully integrated with 
Final Cut Pro, it supports batch processing, and it works.

The benefit to using MPEG Streamclip is that it is free, which means you can use it on a system 
which doesn't have Final Cut installed, and it supports transcoding into far more formats than 
Compressor.

Both are good choices. 

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=91


USING COMPRESSOR

To convert a clip in Compressor, click the Add Clip icon in the top left corner to import your file.

From the Settings tab twirl down Apple, twirl down Advanced Conversions, and select the HDV 
option that most closely resembles the footage that you shot. In this case, I'm using HDV 
1080i/60.

Note: You can also transcode the .M2T file into another format for editing. For my 
projects, I would probably transcode into ProRes 422. (Not the HQ version 
because HDV doesn't have a high enough quality to justify the increased file size.) 
However, as our goal was to create an HDV file compatible with Final Cut, we will 
transcode into HDV for this example.

Drag the setting on top of the file we just imported into the Task window. With Compressor, you 
only need to set the OUTPUT. Compressor will automatically determine the file type of the 
source file.



From the Destination tab, select where you want the compressed file to appear. 

In this case, we want the compressed file to be stored at the same location as the source file, so 
we select Source and drag this destination on top of the file we just added the Setting in the 
Task window.

Note: In real-life, I create a custom Destination, called "Compressed Files" on my 
second drive, which is where all my compressed files get stored. This makes 
finding compressed files a lot easier because I don't need to remember where the 
source file was stored.

Once you've applied a Setting and a Destination, click Submit in the lower right corner of the 
Task window to begin the compression.

At this point, you can quit Compressor, as it is only used to set up a file for compression. Other 
software does the actual compression.

USING MPEG STREAMCLIP

MPEG Streamclip, by Squared 5 Software, is designed as a general purpose video converter.

This free utility is like the Swiss Army knife of video - it converts almost anything to almost 
anything.

Here's a quick look at how it works.

http://www.squared5.com/


Start MPEG Streamclip and drag the file you want to convert on top of the five blue dots. 
(Normally, I would say "into the center of the window." But, how many other applications have 
very kindly put five blue dots in the center of their application? It makes my life easier.) 

 



Here, for example, is a green screen shot that I want to convert from M2T to HDV to illustration 
problems with shadows in keys. (This is Andrew, by the way.)

 

From the File menu, select Export to QuickTime. Just as with Compressor, you only need to 
tell the application how you want the file output. It will figure out what kind of file the source is. 

With dozens and dozens of different video formats to choose from, I selected HDV 1080i/60. 
Again, we could just as easily transcode this to ProRes, or some other format. 

Note: In talking with Graeme Nattress, I learned that converting HDV to DVCPRO 
HD is not a good option as both are compressed formats and tend to degrade the 
image more than necessary.



This screen looks more frightening than it is. Mainly because almost all the defaults are fine. 
Once you've selected the codec (HDV), slide the Quality slider to 100%, then...

 

.. click the Make Movie button.

Your video immediately starts to export. 

Cool.

UPDATE - Feb. 3, 2009



Tom Wolsky points out:

If you don't have Final Cut Pro installed, or some other pro app, you will probably 
need to purchase from Apple the MPEG Playback Component, which is I think 
about $20. 

Larry replies: Thanks, Tom, for the update. (I also fixed the graphic.)

UPDATE - Feb. 7, 2009

As soon as I released my newsletter, I had several people tell me about ClipWrap, a new piece 
of software. Dave Barnard's comments were similar to what others wrote:

An alternative to re-compressing HDV .M2T files is to use Divergent Media's 
Clipwrap software, which re-wraps the files to an FCP compatible Quicktime 
format much faster than transcoding. It also doesn't need the extra disk space 
transcoding requires, very useful when you have several hours of material.

I used Clipwrap very successfully recently for a direct-to-disk multi-camera 
recording system for the Royal Liverpool Philharmonic Orchestra. A few minutes 
after a performance, over 4 hours of HD footage was ready for multicam editing in 
Final Cut - everyone was amazed!

Great work on the newsletter, always good to read - including the make-up tips! :) 

The Powder Gel looks well worth having around for any studio shoot situation - 
thanks for the heads-up

Good to see you are doing the Pro Techniques seminar in London, see you then

Larry replies: Thanks, Dave. I always like hearing from people that are using the product. See 
you in London! 

[ Go to Top. ] 

READER MAIL 

THOUGHTS ON AUDIO METERING

Here is a dialog between Rich Roddman and Woody Woodhall about last month's article on 
audio levels. Woody is a professional audio engineer, president of Allied Post, and president of 
the LA Post-Production User Group.

Rich Roddman writes:

Thanks for another great newsletter. I always learn something new.

I just want to be sure I understood your article on the audio measuring formula you 
received from Woody Woodhall.

If I have the tone in my Edit to Tape set at -18 and I am recording to a analog deck 
such as a Beta SP, if I read this right I should set the deck's VU input levels to -4 

http://www.clipwrap.com/
http://www.alliedpost.com/PAGES/mainC.htm


for correct calibration? 

I have always found setting meters in FCP or Pro Tools out to analog meters 
confusing. I ALWAYS check playback for distortion or over-modulation. And it 
seems when ever I try to find a correct ratio I get different answers from the station 
engineers where I send my spots.

Any clarity in this area would be grateful.

So, I sent Rich's questions over to Woody Woodhall who wrote back:

Rich - Just curious why you are using -18 as a ref tone. We have found that in the 
crazy world of audio specs (which seem to have no rhyme or reason) that -20 in 
the US is the standard. Are you submitting to Europe or is this for the US? I will 
sheepishly admit that I haven't looked at a VU meter in years but in times of yore 
(OK a few years back..) we would calibrate -20 dbfs tone to 0 on the VU meter. 

If this is for broadcast my experience is that the "peak" levels delivery specs are 
either all over the place or non-existent. In Dec I delivered a commercial to Time 
Warner cable, I asked for their audio specs. They sent me a very nice sheet that 
had a lot of information regarding the video and a sentence that said "Program 
Left should be Channel 1 and Program Right should be Channel 2. " I then called, 
found a master control operator who told me to "do whatever you usually do." So 
much for standards...

Rich writes back:

Thank you for your time in this matter. To answer your question over a year ago 
we (the post house I work for) switched to send our broadcast and cable spots via 
DG Fastchannel. To do so you first have to be approved by there engineers for 
quality control. The video was fine but we were failing for audio. Their engineer 
told me that their rules are the baseline of the file should playback at -18 db with 
the peeks being no more that +6 db over that. So I remixed the test spot in Sound 
Track Pro using the method I learned from one of Larry's seminars using 
normalization and limiters. Then in Final Cut I need to drop the timeline -6 db 
before exporting the file and compressing in Encore. That was the formula that got 
me approved for DG. Thinking consistency would be a good thing I reset the 
output of my Final Cut system to -18. The broadcast stations here in the Tampa 
area still want spots on beta sp and it is more cost effective send an intern that via 
DG.

I will set my system to -20 since that won't effect what I do for DG. 

Woody concludes:

The crazy thing here is that we are three working, experienced professionals and 
still here we are scratching our heads! Europe uses -18 as a ref, US -20 as a ref, 
some gear comes with a default -12 as a ref... and then the frame rates 
craziness... so much for our technological improvements... All the best,

Larry wraps up: And who says that video engineers should be the only ones confused about 
standards?
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BLU-RAY RANT

Jason Chong sent me the following:

I love listening to The Buzz, it keeps me entertained, informed and most of all 
inspired about the industry.

I wanted to put my thoughts into the debate as to the distribution war between blu 
ray and the internet.

We all hear the phrase "content is king" ad nauseam, but I think it's an ideology 
that has been forgotten in this debate.

As a consumer, when I buy or hire a movie, I don't just want to see the film, I also 
want to see the special features. I think for a lot of consumers, the decision to 
upgrade from VHS to DVD was less to do with quality, and more to do with extra 
content. There will always be early adopters who want to show off their big TV's 
and latest sound systems, but for the mass market who plug their DVD player into 
their 4:3 TV, the quality isn't nearly as important as the experience being offered 
around the feature.

And I think the same can be said about the format that will replace DVD. My 
problem with online distribution is that you get the movie, but you get nothing else 
in terms of commentaries, behind the scenes featurettes or interactivity. And it 
seems that if one of the formats was perfectly suited to give consumers not just 
their feature, but also extra goodies, it would be online.

Blu Ray offers extra content, but it is usually the content is just HD versions of 
what you get on the standard DVD. I believe that for the average consumer, while 
the experience change from VHS to DVD was a massive step up, DVD to Blu Ray 
is just StepHD. And therefore, why do we expect them to upgrade their existing 
home theatre equipment (in the meantime relegating all their current DVDs to the 
"old technology" pile) if we're not offering them anything else apart from more 
pixels?

For an industry that stresses that it's not simply that we have the technology to 
create amazing monsters, but what we make those monsters do that's important, 
Hollywood has got caught up in it's own hype, and forgotten that advancements in 
technology don't equate to happier customers and therefore don't equate to profit. 
If it doesn't benefit the average viewer, why should they buy it?

At this stage, I have no intention to buy a blu ray player, or rent movies from 
iTunes as I don't believe either of them offer me more value than a DVD with extra 
content.

What would make me want to jump on either wagon? That's the billion dollar 
question. Back in the day, people could buy movies, then they could buy movies 
with supporting stuff about the movie. What's next? A behind the scenes of the 
making of? I hope not, but I'd certainly be curious! Perhaps it utilizes the trend for 
people to combine all their entertainments onto a singular media centre (PC/
AppleTV/PS3). Could they offer game demos? A movie/extra features/soundtrack/
video game package? Access to Q&A sessions with the cast and crew? Social 
networking benefits?

I guess that's up to content producers to figure out, see what works and what will 
disappear. I'm pretty excited by what's coming next, but I think we're still a fair way 
off.

http://www.digitalproductionbuzz.com/


Thanks for letting me rant, I'd love to hear your comments if you have any.

Larry replies: Jason, thanks for writing. Our Blu-ray Special Report turned up a lot of interesting 
facts. To listen to our complete Blu-ray Special Report, click here. 
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BLU-RAY REDUX

Robert Dennis writes:

You may have answered this question many times before and I have not seen the 
subject discussed. 

My Question...Is there a way to author and burn HD Blue Ray DVD's with Final 
Cut Studio and DVD Studio Pro? I am an old school video producer that started 
back in the 3/4 U-matic days and have been trying to catch up ever since. 

I purchased a Final Cut Studio 2 system on a medium speed Pro Mac and am 
gradually learning how to edit on this system. I currently do not shoot any HD and 
want to upgrade to HD but am not sure if I can deliver a finished product in HD. 

So therefore my question about can Final Cut Studio 2 and DVD studio Pro create 
and burn Blue Ray HD discs. I shoot events and use 2 or 3 cameras so moving to 
HD would require the purchase of not one but three HD cameras and I do not want 
to switch to HD until land can deliver a finished video or disc in HD to my event 
clients. Thanks.

Larry replies: Final Cut Studio can not. And the current version of Mac OS can not play Blu-ray 
discs on your computer. However, all is not lost. But there are workarounds using other software 
like Roxio Toast and Adobe Encore.

Here's a blog posting that can tell you more. 

[ Go to Top. ] 

NESTING FOLLOW-UP

Bill Sitkin writes:

Read your nesting article and thought I would share one way I use nesting. When I 
complete a project and have made sure that it is exactly the way I want it I select 
the entire project and nest all the clips into one clip. I am not sure why but when I 
take it to Compressor 2 my process time is shorter.

Larry replies: Interesting. Thanks for letting me know.
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MONITORING MADNESS 

Maly Gabor writes:

There is a lot of talk about using calibrated HD monitors for monitoring your work 
out of FCP or Color.

If I do not use an HD monitor I risk having inaccurate color and contrast. I am OK 
with the color piece, you would truly see it in action on an HD LCD but as long as I 
keep my waveforms in the range (monitoring it in Color on the waveform window) 
making sure blacks do not go below 0 and whites above 100 would I not ensure 
they look perfect on all LCDs/TVs for final output even without monitoring during 
post process? Why would I need an HD monitor for monitoring contrast?

Larry replies: Gabor, thanks for asking!

The answer for HD is the same as for SD. The reason we use a monitor is to assure ourselves 
that the color we see is accurate. Especially when we are doing work for clients, we need to 
assure them that the color they sign off on in our edit suite is the same color they will see 
anywhere else in the world they play your project.

The need for monitors does not diminish as we move to HD, its just that the cost of monitors has 
sky-rocketed due to the greater resolution they need to support.

UPDATE - Feb. 3, 2009

Ben Balser writes:

To Maly Gabor I would say, in addition to your own comment, to think of those 
scopes as a "technical" control, making sure you're broadcast safe. Think of the 
HD Production Monitor as an "artistic" control. Just because something is 
broadcast safe, doesn't mean it looks pretty. Scopes don't tell you the look and 
feel of what you're producing, only that it is within engineering standards.

Larry replies: Thanks, Ben. 
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COMPRESSION CONUNDRUM

Herb Isaacs writes:

I have a 1 minute clip I want to make a streaming video on my website. The 
master is 720x480 NTSC. I would like the final product to be sized at 480x320. I 
have tried several methods of export including using Compressor at the highest bit 
rate, but it always comes out smaller...I think 320x240. Is there any way I can 
control the size of display on the site?

Larry replies: Herb, it isn't the data rate that determines image size. Its the geometry tab in 
Compressor.



By default, it is set to make all web video at 320 x 240. You change this by loading your setting 
into the Inspector...

... clicking the Geometry tab, and changing the Dimensions of the encoded pixels to the size you 
want.
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MORE QUESTIONS ON COMPRESSION

Chris Driscoll writes:

On your lynda.com Compressor 3 tutorial you discuss chaining. You show a two 
step process to convert an HD video into MPEG-2 for a SD DVD, first using an 
animation codec. You are demonstrating chaining, so the exact settings of the 
conversion to the animation codec are not discussed. (I tried the Compressor 
manual, but he word “animation” is not even mentioned).

1. What are the proper settings and which animation codec should I use if I am 



going 16x9 HD into 720x480 16x9 SD (with the intent of following this with a 
MPEG-2 compression for SD DVD)? 

I will be working primarily with 60i. Is there a way to use a similar two step 
workflow for compressing to SD MPEG-2 in 24P also (I noticed that the animation 
codecs in Compressor are all NTSC or PAL)? 

2. I know you recommend an average bit rate of 5.5 and a max bit rate of 7.2 for 
compressing to MPEG-2 for SD DVD’s. Compressor defaults to an average bit 
rate of 6.2 and max bit rate of 7.7, which you said is also fine. If I’m making shorter 
DVD’s and space is not an issue for me, is this the highest average and max bit 
rates you would recommend to insure compatibility with any DVD player?

Larry replies: Thanks for writing, Chris!

There is only one Animation codec. Think of it as totally uncompressed video. HUGE file sizes, 
but no loss in quality. It will exactly mimic whatever image size, frame rate, and scanning 
(progressive vs interlacing) you are using. It is an intermediate codec - it is designed to move 
files from one format to another. It is not designed for real-time playback and definitely not for 
distribution. 

For the answer to your second question, see the next story.
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STILL MORE QUESTIONS ON COMPRESSION

Catherine writes:

If I have a 10 minute show and take it through Compressor, the only (best) choice 
I have for compression is using the "90 minute best quality" selection. It seems like 
an awful waste. Is there another way that could make the show look better, even 
though it looks good with the "90 minute" selection. I'm thinking there might be a 
way of compressing less than for a 90 minute show.

Larry replies: Thanks for writing, Catherine. It is always good to hear from you. MPEG-2 doesn't 
work the way you are asking.

You can leave the settings as is for even very short videos. Boosting the data rate causes 
stuttery playback on most set-top boxes. Don't raise the average bit rate above 6.5 and don't rate 
the maximum bit rate over 7.5.

Lower is actually better.  
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LOST...

Michael Crosswhite writes:

Larry, I've been through your Lynda.com training in FCP (huge help!), but I ran 



across something that I've never seen before. I can't figure out how I did it, and I 
don't even know what to search for on the internet. If you notice, below my video 
clip, and each of my audio channels is a section. When I right click on it, it appears 
that it will let me set some sort of key framing for the clip(?). I sat here thinking of 
how I could undo it, but I didn't even know what to search for. If it helps, I was 
using the option/command/T to put the default audio transition. I must've hit a 
wrong key somewhere, but I don't know which. I would greatly appreciate your 
help!

Larry replies: Yup, you hit the wrong key. 

What you are seeing is the ability Final Cut Pro provides to set, edit, and remove keyframes in 
the Timeline. I'm of two minds about the feature and haven't written about it. (Though it is 
discussed in most Final Cut books.)

You toggle this timeline display on or off by either clicking the button with the red circle around it 
in the lower left corner, (I added the circle, by the way) or typing Option+T - which is what got 
you into this mess in the first place.

By the way, the blue line the cursor is pointing to indicates that a motion effect has been applied 
to the clip. If the line is green, it means a filter has been applied to the clip.

The good news is that toggling this on or off doesn't hurt anything -- its just confusing.
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TEMPLATES BY A DIFFERENT NAME

Rich Bowers writes:



I work for a university and have shot a couple of dozen interviews with key faculty 
– we are creating a series of “Profiles.” The Profile has a standard look – a 
template, if you will – that certain standard shots fit into. Some of the unique 
footage needs to be integrated with the stock footage, and there needs to be 
some audio tweaking with each one as well. So I can’t just create a piece of stock 
footage I can use to lead in and lead out of each piece. 
 
So the question: Is there a way to create a sort of a template that contains certain 
video and audio elements roughly in place, so that I can have a quick base 
sequence to work with? As it stands now, I am recreating each opening and 
closing bit for each of these productions. 
 
Can a standard sequence be created, and then copied from project to project? 
Without losing links to the content they point to? Or is there another technique?

Larry replies: The answer is yes, but they aren't called templates.

Create a sequence that contains your common elements. You can easily duplicate this in your 
project (Option+D) or copy and paste this from one project to another and all links will be intact.

UPDATE - Feb. 3, 2009

Ben Balser writes:

For Rich Bowers, I recommend what I do, as I use several templates for my digital 
signage projects. I create my templates, save them all in one single project called 
"DS Project Templates". When I start a new job for a client, I open it, immediately 
Save As to the client folder with client/project name, and then delete the Sequence 
templates I don't need on this specific job. 

I also have my own media management style, so all of my Bins are already made 
and ready to populate. You could also set up several Projects as templates, if that 
fills a need better, and keep those template projects in a "Project Templates" 
folder, using the Save As function in the same way. I do this as sometimes I am 
given all HDV footage, sometimes all SD footage, and sometimes mixed format 
footage, so I have project templates all set up with those formats (Pro Res for 
mixed format), as the defaults.

Larry replies: Thanks, Ben. 
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ARCHIVING IS A MESS

Lauren Dunbar writes:

After spending a million hours going through the lynda.com tutorials (FCP 6 + 
Compressor) and then your edit library articles, I now realize that 1) I'm not crazy 
(yet); and 2) "archiving" my client's movie (shot and edited in DVCPro HD, 
720p24) onto mini-DV tape, either SD or HD, may be a hopeless "over the 
rainbow" dream. 

Choosing the correct method to "transcode" the final nested sequence in 
Compressor, then export to QT movie with correct settings may be the secret. But 
in my tests, I haven't yet been able to Print to Tape. 



I am now testing your "Technique: Exporting DVCPROHD to HDV, pub. Aug. 
2006" because I may be able to preserve some quality by printing to video using 
my Canon HDV20 camcorder (uses standard mini-DV tapes) rather than the SD 
Canon GL. 

Here's what I'm doing: 

1) Bring into a new sequence the final QuickTime movie (self-contained) which 
was exported using orig. AV Settings for DVCPro HD 720p24. Note: Actually, the 
"file properties" say it's DVCPro HD 720p60. 
2) Export to QuickTime Movie, but changed the settings to HDV 1080p24 
3) CHECK Recompress all frames 
4) CHECK Make movie self-contained

Is it possible or impossible to print to a mini-DV tape (HDV or SD) from a 
(DVCPRO HD) FCP final nested sequence?

And yes, I know all of this archiving to tape from FCP is a colossal mess, but 
somebody must have found a work-around. I've given my best trial and error shot 
at this and getting nowhere. Any suggestions? 

Larry replies: Lauren, my sympathy goes out to you. This is NOT easy stuff.

First, you can NOT archive ANY HD material to Mini-DV tape EXCEPT HDV -- and then only if 
you have an HDV camera. DVCPRO-HD is impossible to record to MiniDV. 

So you are not going nuts. It can't be done.

However, you can transcode (convert) your HD material to SD, then save the SD material to 
MiniDV tape -- the problem is that you will lose all that wonderful High-Def imaging, because you 
are converting it to SD.

The procedure you outline will work and it will be HD. However, bar fights break out when people 
discuss the relative merits of DVCPRO-HD vs HDV.

Will it work? Yes.

Will you like the quality? That's up to you and your clients.

Is it better than nothing? Yes.

Is it ideal? No.

Do we have a better idea? Nothing for less than $2,500.

Here's an article that may help: http://www.larryjordan.biz/articles/lj_backup_test.html
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BEST WAY TO EXPORT

Paolo Raho writes:

http://www.larryjordan.biz/articles/lj_backup_test.html


I had a quick question about exporting in FCP. 

I'm very familiar with all of your tutorials, and I know for the highest quality it is 
always recommended to export the sequence under the settings in which the 
footage was shot and captured. I was reading a couple of forums lately and they 
were discussing the idea of exporting a DV sequence as 8 or 10 bit 
uncompressed; a process that would yield a higher quality image, specifically for 
text and graphics. 

I wanted to get your opinion on this, whether there was any truth to it. And one 
other question along the same lines, let's say I have shot and captured in 
DVCPRO HD, and exported a sequence under the same settings, has my 
exported movie suffered any quality loss, or has it remained identical to the 
captured footage? That is to say, does exporting, even under the correct settings, 
result in an quality loss?

Larry replies: Paolo, thanks for writing!

These are excellent questions, but not easy to answer in less than a book.

Here are the short answers - less than book length.

1. Is it better to export as 8 or 10 bit uncompressed? My feeling is that if you are shooting DV, 
no. If you are working with 8-bit or 10-bit source material - yes. The problem is that DV does not 
display at high quality on a Mac monitor. For this reason, people assume that the video is poor 
quality. This is a display issue, not a video quality issue.

I've done a test where I export DV footage using the Animation codec - the highest quality SD 
codec on the Mac - and the DV codec. I compressed both and compared them. To the eye, the 
compressed versions were identical. The intermediate versions looked significantly different - DV 
looked far poorer than the Animation codec. But after compression they looked the same.

Here's an article that explains why: http://www.larryjordan.biz/articles/lj_dv_look_bad.html

2. Does DVCPRO HD change? Well, that depends. If you are adding effects, transitions, or 
something requiring rendering, then, yes, the video is being altered from its original state. On the 
other hand, that's why you applied the filter in the first place. As to whether that's a quality "loss" 
that depends on the filter you added - I would suggest that a color correction filter, properly 
applied, will make the clip look better.

If you are simply putting the video to the timeline and not adding effects what you get out is the 
same as what went in.
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TRACKING THE MISSING FONT

Stanley Kolk writes:

I've got a really dumb problem. I've imported an old EDL and am working some 
more on that edit. Everything works fine except that I can't get the old titles to 
recreate... Is there a way to do this? Now there's no way to find out which font, 
size etc has been used before...

http://www.larryjordan.biz/articles/lj_dv_look_bad.html


Larry replies: If it truly is an EDL, then, no. Because EDLs don't track font or design issues.

If it is an older FCP project, loading the clip into the Viewer and clicking the Controls tab should 
show text and size info. However, if the font is no longer installed on your system, it will show the 
first font alphabetically on your computer, rather than the font you used.
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THE WORLD IS GOING TAPELESS

Adam Lloyd Connell writes from Australia:

Quick questions for you: In Australia, there has been a big uptake of HD, 
particularly in the XDCAM, and HDV. What is it like in the US? Is a lot of TV work 
still filmed, and edited on MiniDV/DVCAM/SD DigiBeta?

Also, with the advent of many tapeless formats, such as Panasonic's now 
professional versions of AVCHD, the XDCAM and XDCAM EX, what do you think 
is the future for tape based formats such as HDV or DVCAM. I ask as although 
currently I have been working as a an editor (one feature film, and other people's 
TVCs/documentaries) I am looking at expanding into creating a business filming 
and editing, and being mechanically minded prefer the idea of tape based HDV for 
my needs, but don;t want to suddenly not be able to buy 6mm digital tapes.

Larry replies: Adam, the broadcast world in the US is going HD as fast as it can. While a lot of 
material is still shot SD -- especially news -- the handwriting is on the wall and it says "HD."

As well, tape is quickly falling by the wayside. I wish this weren't true, because we have not yet 
solved the archiving problem, but it is. The problem is that there is a VAST panoply of totally 
incompatible video formats out there and no signs the industry is standardizing on anything. So 
whatever you buy, expect it to be obsolete in two years.

Sorry...

UPDATE - Feb. 3, 2009

Ben Balser writes:

As for the tapeless issue, I get asked this as a trainer/consultant all the time. And I 
have mixed feelings about it. My standard answer is, "tapless is not for everyone!" 
I have a few students who've gone tapeless only because they've seen myself and 
a few others go that route, only to batter me with calls about using it, and archiving 
it. There are certain folks I've out right told, knowing them and their work well, 
"stay away from tapeless!" There are those who do quick promos, trash all footage 
and such when the project is done, and move on. Great, go tapeless. 

I use tapeless because I love the DVCPRO-HD format, and without tapeless, I 
would not be able to afford it (price tapes and decks for this format). But for 
anyone who needs to archive everything, I'd say stay the heck away from tapeless 
unless you want to invest in a DLT drive, or a ton of hard drives, and take major 
risks. I'm a huge fan of the Firestore FS-4 (a proven workhorse) for wedding 
videographers and such, as you get the speed of tapeless, with the convenience 
of tape archives.



On the plus size of tapeless, and this is not about acquisition, I've found more and 
more television stations here in southeast Louisiana are not only able to, but 
prefer me to give them an FTP URL to download the Quicktime file for broadcast. 
Interestingly, New Orleans TV stations are far behind the rest of the world on the 
technology curve and using no FCP, Lafayette is mostly totally tapeless, on the 
very front of the front lines of technology, and almost 100% FCP. As a producer, I 
find it really nice to be able to upload a QT file to my FTP site, email a program 
manager, know I've delivered in the highest quality possible, and be done with the 
project. I save on gas, tape, time, etc, etc, etc. Also, more and more of my work is 
now digital signage, thus those deliveries are all on-line to signage player 
computers (mostly Mac Minis). Even the units that have no Internet connections, 
I'm delivering content on DVD or USB sneaker net, tapeless! Tapeless is the best 
method of delivery for me. Acquisition is still a major issue, though, and the single 
reason I do not recommend it to everyone. Acquisition means you have to become 
more IT savvy than you were, and have the archive issues.

So, I don't hate tapeless, I see it as a wonderful way to work, I see it demanding pr-
editors to become better educated in IT, but it's a wonderful way to work. 
Archiving, that's the one big issue here, archiving. Fortunately, some of us have 
no need to archive. But for those who do, yes, it is an issue to be dealt with but not 
impossible, and admittedly not for everyone.

It would be interesting for you to do a survey to see how many of your readers and 
students are able to deliver on-line or by sneaker net, tapless products, versus 
tape, and in what cities they are able to do this in.

Larry replies: Thanks, Ben. The survey idea is a good one and I'm hoping to run one in next 
month's issue. 
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MIXING AUDIO

Kelly Coleman writes:

The Time Warner specs say, the sound must be mixed on channel 1 or 2. I am 
using A1 - A4 for voice over and music. Will our export automatically spit out 2 
audio channels or do I need to some how mix down to two tracks before I export?

From Time Warner: 
All spots must be complete. Any editing, tagging, or audio mixing is 
your producer's responsibility. All audio should be mixed on channel 
1 or 2 including any voice over and any music that is to be included 
with the finalized version of the commercial. We do not have the 
facilities or permission to perform any post-production work on client 
spots. Mixing audio is post-production work that is part of the 
creative process.

Larry replies: Final Cut is, by default, two tracks of audio out. In general, that means stereo. 
Regardless of how many tracks are in your timeline, unless you change the audio outputs 
(Sequence > Settings > Audio Outputs) to multi-channel, all your exports will be two-track 
stereo.
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JOURNALING A HARD DISK

Cesar Ramirez writes:

Hello my name is Cesar and I do post production too, I work in audio with 
ProTools I'm also a DJ and I use FireWire drives for data storage, but also to run 
sessions from it ,and also use FCP ..... I recently bought a second firewire drive for 
back-up and I did formatted with OSX 10.4 with journaled option ON.... So you 
think I should reformatted this drive?, my other drive I formatted off (I didn't know)

Larry replies: Thanks for writing!

Journaling should be ON for your boot drive. Journaling speeds up recovery after a crash -- very 
well advised for your boot drive.

Journaling should be OFF for all data drives. Journaling takes extra write time, slowing down 
capture. Turning it off on all drives used for video speeds capture and rendering. Apple 
recommends doing this.

You change journaling settings in Disk Utility. Sometimes you can change journaling without 
reformatting. Remember, reformatting will erase all the data that is currently on the drive - so be 
sure to back up the data first.

[ Go to Top. ] 

WRAP-UP

Well, that's about it for this month. 

For current news and in-depth interviews on what's happening in our industry, be sure to listen to 
the Digital Production BuZZ every week.

�●     Please check out my latest video tutorials. 
�●     Visit our store and buy something nice. 

In the meantime, please continue sending me your comments and questions. I love hearing from 
you and enjoy the conversations that develop around these stories.

Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

http://www.digitalproductionbuzz.com/LiveThisWeek
http://www.larryjordan.biz/training/online_tutorials.html
http://www.larryjordan.biz/store
mailto:larry@larryjordan.biz?subject=Newsletter comments
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends 
to sign up at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list 
is not sold, rented, or bartered. The only person who knows you are on this list is 
me.

The information in this newsletter is believed to be accurate at the time of 
publication. However, due to the variety of possible system and software 
configurations, the author assumes no liability in case things go wrong. Please use 
your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This 
newsletter has not been reviewed or sanctioned by Apple or any other third party. 
All trademarks are the property of their respective owners and are mentioned here 
for editorial purposes only.

Text copyright 2009 by Larry Jordan & Associates, Inc. All rights reserved. This 
newsletter may not be reproduced or published in any way, in whole or in part, 
without specific written permission from the author. 

Links to my home page, blog, or website articles are welcome and don't require 
prior permission. 
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